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Using Quik! Help 

Using Online Help 
Quik! includes complete documentation and help in an accessible PDF-based system, using Adobe® 
Acrobat®. The help system includes information on all the features and components of Quik!. This 
help file is designed to provide easy navigation online, and can be printed out to provide a desktop 
reference for using Quik!. Additional help can be found on our website at 
http://www.etiforms.com/support.aspx and in our online KnowledgeBase at 
http://www.etiforms.com/support_search.aspx.  
 
While this help guide will touch on some of the features of Adobe Acrobat Reader and other versions 
of Acrobat, should you require more in-depth help with an Acrobat feature, please use the help guide 
that Adobe provides. You can find Adobe Acrobat help by opening Acrobat and choosing Help > 
Acrobat Help from the file menu.  
 
Getting and Using Help… 
To open Quik! help, choose Help > Contents from the file menu. Help will launch Adobe Acrobat and 
open the help file. Once open, click on the item you wish to view from the index and the 
corresponding Help topic will appear.  To Move Back use the Back button found on the Acrobat 
toolbar. If your Acrobat toolbar is not showing, you can show it by choosing Window > Toolbars > 
Show Toolbars. 
 
To retrace your viewing path, use the Back button on the Adobe Acrobat toolbar.  

 

 
 

For additional help, please visit our website (www.quikforms.com) or contact us: help@etiforms.com. 
 

http://www.etiforms.com/support.aspx
http://www.etiforms.com/support_search.aspx
http://www.etiforms.com
mailto:help@etiforms.com
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 What’s New In This Version 

Quik! Forms Library Version 5.1.0 
This version of Quik! Forms Library introduces the following new features: 
 
Software Updates 

• Combine multiple forms into a single document 
• Launch your forms from the web 
• Support for remote installations of Quik! 
• Enhanced form search capabilities 
• Update Service upgraded 
• Quik! now supports over 26 different databases!! 

 
New Databases 

• GBS 
• Inscomm 
• Quik! Data Entry Template (MS-Excel) 
• Upgrades to several databases 
• Enhanced Text File support 
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Quik! Overview 

Overview 
Quik! Forms Library 
Quik! is a desktop application that automates the process of filling out forms. Forms can be created 
blank with only the available rep information or when connected to a database, forms can be pre-
populated with client information found in your database. Quik! is the perfect complement to your 
existing contact management system and way of doing business. 
 
When creating forms for clients, Quik! dynamically 
reads your database to gather client information that 
can be placed on forms. Once the form is generated, 
you can make changes to the data on the form 
without affecting your database. In fact, Quik! does 
not write any data back to your database – your 
contact management system will not be modified or 
changed by Quik! in any way. The advantage to 
using Quik! is only having to manage your client 
information in one program! 
 
Quik! is comprised of: 

 Your Contact Management Database 
 Quik! Forms Library and Forms 
 Adobe Reader or Acrobat 

 
When setting up Quik!, you’ll be asked to connect Quik! to your database, enter your rep information 
and download and/or install forms. The entire process should take five minutes or less to setup. 
 
 
Quik! Update Service 
The Quik! Update Service is an application that 
comes with the Quik! Forms Library. It is designed to 
interface with the Quik! website to keep your forms 
and software up-to-date.  
 
When you launch the Update Service, it will 
automatically download your update file, which 
indicates which forms need to be updated. Then, 
each form that can be updated will be downloaded 
and installed. Overall, this method of finding, 
downloading and installing forms is highly efficient 
and requires very little effort on your part. The only 
thing you have to do is run the Update Service. 
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Installing Quik! 

BEFORE INSTALLING 
System Requirements 
Quik! has the following minimum system requirements: 

Operating System:  Microsoft Windows 98SE, 2000, NT 4.0 with Service Pack 5 or 6, 
XP (Mac OS is not supported) 

Processor Speed: Intel Pentium Processor 
RAM: 128 MB (256 MB recommended) 
Hard Disk Space: 150 MB 
Browser: Internet Explorer 5.0 or higher 
Internet: Ability to connect to the internet to download form updates. 
Other Software: Adobe Acrobat Reader 5.0 or higher (Acrobat 4.0 is not supported) 

In order to save forms completed using Quik!, you must own the full version of Adobe Acrobat or 
Adobe Acrobat Approval. Both products are available for purchase on the Adobe website 
(www.acrobat.com).  
 

READ THIS! 
Quik! requires that Adobe Acrobat® Reader®, version 5.0 or higher is installed on each PC using 
Quik!. If you try to “Start” forms and the form will not launch in Adobe Acrobat, check your version of 
Acrobat and make sure that you only install version 5.0 or higher. Acrobat may not work properly if 
you have multiple versions installed. 
 

Downloading Quik Software 
As a Quik! subscriber, you can download the Quik! software any time you wish, and as many times as 
you want. The install file, quiksetup.exe, is a program that will install the Quik! software on your 
computer. We recommend downloading the setup file and saving it to a shared drive on your 
network or in a folder on your hard-drive where you normally save downloaded software.  
 
To download the Quik! software, log in to www.quikforms.com and click the Download Software link 
on the home page. Or, click on the My Account button  located in the left-hand column of 
the Quik! website. From the My Account page, click the link to the Download Center.  
 

From the Download Center, click the Download button  to download the software. 
You will be prompted to Open or Save the file. We recommend that you choose “Save” so you can 
install the software later on other PCs. 
 
 

http://www.acrobat.com
http://www.etiforms.com
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Installing On A Network – CLICK HERE FOR AN ONLINE TUTORIAL 
The power of Quik! Forms Library is enhanced when you share the single program amongst all of 
your staff in your office. Install Quik! on your network server to share the same forms, groups and rep 
information, plus you’ll only have to get updates for one set of forms. The program will only take a few 
moments to install. 
 
When installing Quik! onto a server, you must install the program on the actual server machine – 
do not attempt to install to the server from a PC over the network. Alternatively, Quik! can be installed 
on one PC for a single user (see “Installing On A Stand-Alone PC). 
 
To install Quik! on a network, do the following: 
 

1. Go to the actual server machine – ask your administrator to help you 
2. Login to the server with ADMINISTRATOR rights 
3. Locate the quiksetup.exe file you downloaded 
4. Double-click the quiksetup.exe file to begin the installation program. 

 
The Quik! installation program will prompt you to continue with the screen below.  

 

http://www.etiforms.com/supportfiles/tour/QuikHelpNetworkInstall.htm


Quik! Help   

  8  

 8  

Click NEXT to continue through this screen. Continue clicking next until you get to the screen that 
asks for a Destination Folder (see image below).  
VERY IMPORTANT! During the installation process, you’ll be prompted to verify the DESTINATION 
FOLDER. When installing on a server you must change the destination location on your server to a 
shared folder where all of your users can access the program. (For example – 
D:\SHARED\APPS\QUIK FORMS LIBRARY\). If you accept the default location, you may not be able 
to access the software from other PCs on the network. 

 
Click the Change button to choose a location on your server’s hard-drives where network users can 
access the program. Most system administrators setup the server with one or more shared folders for 
applications and/or data – after locating a shared folder, create a folder in there for Quik (perhaps 
called “QuikForms”). 
 
The next step will ask you to choose either a “Full Install” or a “Minimum” install. Choose the Full 
Install to install the program. Only choose the Minimum install when setting up individual PCs on a 
network that will access the program over the network. Click Next to continue. 
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After you select the Setup Type (per the image above), continue following any additional prompts, 
clicking the Next button to continue until you reach the last screen that will prompt you to complete 
the Install – click the Install button.  
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Once installed, the program will create a shortcut on both your desktop and in your START > 
PROGRAMS > QUIK menu.  
 
After installing, run the Quik! Forms Library application (double click the Quik! shortcut on your 
desktop) and follow the setup wizard process to connect Quik! to your database (see “Setting Up 
Quik! For The First Time”).  
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How To Setup Network PCs To Access Quik! On The Network 
Please visit each PC you wish to run Quik! on and do the following: 

1. Run the quiksetup.exe program you downloaded to the server.  
2. During the installation wizard, accept all the default prompts until you reach the Setup Type 

screen (see below) 
3. On the Setup Type screen, choose “Minimum”. 

 

 
 

4. Continue until you get to the Install screen and click the Install button (see below). 
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5. Setup a shortcut icon to the Quik! Forms Library program that you installed on the server  
 
A shortcut icon is a desktop icon that points to the Quik.exe (software) file on your network. If 
you installed Quik! on the server in a location that is shared with all users, you can set up the 
icon by doing the following:  

a. To setup a shortcut, right-click the mouse in an open area of the desktop. Choose 
“New” “Shortcut” and follow the prompts.  

b. Browse for the quik.exe file that was installed on your server.  
c. Once you find the file, click Next and follow the prompts to complete the shortcut. 
NOTE: In order for Quik! to operate on the network, you must create a shortcut to the 
program on a mapped network drive – a mapped network drive has a letter (e.g. S:\ or 
H:\, etc.). 

 
6. After completing the first PC install, run the Quik! Forms Library application on the PC you just 

installed it on. You will be prompted to follow the Quik! setup wizard once again to connect 
Quik! to your database – you will only have to do this the first time Quik! is run from a PC (see 
” Setting Up Quik! For The First Time”). 
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NOTE: If Quik! says that the license has expired on the PC you just installed on, simply run 
the Update Service from that PC. To run the Update Service, click the Get Updates button in the 
upper right corner, below the Quik! logo. 
 
 
Installing On A Stand-Alone PC 
To install Quik!, double-click the installation file that you downloaded (quiksetup.exe). The program 
will only take a few moments to install. 
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Accept the default settings in the install wizard for the Destination Location 
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The next step will ask you to choose either a “Full Install” or a “Minimum” install. Choose the Full 
Install to install the program. Since you are not setting up Quik! to run over a network, you can ignore 
the Minimum install option. 

 
Once installed, the program will create a shortcut on both your desktop and in your START > 
PROGRAMS > QUIKFORMS menu.  
 
Now that the program is installed, run Quik! for the first time to complete the setup and to connect 
Quik! to your database. See the next section for more information. 
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Setting Up Quik! For The First Time 
After installing Quik!, run the Quik! Forms Library to complete the setup. The first time the application 
is run, you will be prompted to follow a setup wizard which will ask you for your web username and 
password, a database connection, your rep information and to confirm your internet settings. 
 
Quik! Installation Wizard 

 
 
Quik! Installation Wizard: Step 1 of 4 
Enter the same username and password you use to login on the Quik! Forms website. This 
information is used to obtain your form updates. 
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Quik! Installation Wizard: Step 2 of 4 
To connect Quik! to your database, Step 2 asks you to choose the type of contact management 
system you use, as well as the location of your database file. Alternatively, if you do not have a 
database, you can use the Quik! Database by selecting Quik! Forms Library Database as your 
database (skip Step 2 if you choose the Quik! Database). 
 
 
1. Select Your Database 
Start by selecting the database in the list that best matches your contact management system. Quik! 
supports several database products, and often supports several versions of a given product. For 
database programs that have a version number similar to “Version 3.X”, the “X” refers to any version 
number (e.g. 3.1, 3.2, 3.3, etc.). If you don’t see the version number for your product and Quik! has a 
lower version number available, then choose the lower version number as Quik! will probably work 
fine with the higher version numbers. 
 
 
2. Browse For Your Database File 
In order for Quik! to properly read your database, you need to tell Quik! where your database is 
installed. Click the Browse… button to locate your database. NOTE: When browsing for your 
database file, make sure you choose the correct network folder or local folder. By default, clicking the 
Browse button will open a folder where you are most likely to find your database, but your database 
may or may not be in that folder.  
 
Also, when browsing for your database, be sure to check to see if the database file you select is the 
most up-to-date file – if the last modified date of your database is not very recent, then you have 
probably selected the wrong database file. 
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OPTIONAL: UserName and Password 
In order for Quik! to access some databases, you may need to enter your database username and 
password. For example, ACT! databases require your exact username and/or password. 
 
 
Quik! Installation Wizard: Step 3 of 4 
Step 3 will allow you to setup all of your rep information, except for your rep name, which is 
maintained on our website. The items in BOLD letters are the most commonly used items on forms, 
though all pieces of information can potentially be used. There are four major pieces of information for 
each rep – enter the pieces you wish to be pre-populated onto forms (see the screen image below): 
 

- Personal Office Information – enter the rep’s phone number, address, personal info etc. 
 

- Rep Numbers – enter as many rep numbers or variations of rep numbers as you’d like. 
 

- Branch Office Information – This information relates to the registered branch office that you 
work through. If your personal and branch addresses are the same, click the Use Personal 
Address button to save time when entering data. 
 

- Broker/Dealer Headquarters Information – Broker / Dealer information is mostly used on 
forms for other companies (e.g. mutual funds) where your firm has a selling agreement. If your 
branch and broker/dealer addresses are the same, click the Use Branch Address button to 
save time entering data. 
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Quik! Installation Wizard: Step 4 of 4 
Quik! relies on your internet connection in order to download form updates and the latest information 
about your subscription. The last screen in the Quik! Installation Wizard asks you to configure your 
Update Service and Internet Settings. 
 
Update Service Settings 
For most users, accepting the default settings will be optimal. By default, the Update Service will run 
on Automatic mode. Automatic mode means that when you run the Update Service it will 
automatically check for updates, and download and install any updates without you having to do 
anything. If you prefer to have more control over the process and to choose which forms download, 
then change the settings to Manual mode. NOTE: Automatic is best, especially if you schedule 
your Update Service to run over night (see the section on the “Scheduling The Update Service” for 
more details). 
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Internet Settings 
To allow Quik! to access the Internet, you may need to configure your Internet Settings. If your 
company uses a proxy server to access the Internet, check the check box for the proxy server and 
enter your proxy server settings. To check your proxy settings, click the Configure button, which will 
show you your computer’s Internet Settings – click the LAN button on that screen and see if you have 
a proxy server configured (the settings look similar to the Quik! screen below). 
 

 
 
To schedule the Update Service to run, you will need to schedule a task in your Windows Task 
Scheduler (see the section on the “Scheduling The Update Service” for more details). 
 
 
Administrator Settings 
When you setup Quik! on a network, you can use the Administrator Settings in Quik! to restrict PC 
users from performing certain tasks in Quik!. By clicking the Disable PC Features checkbox, you will 
remove the following items from the Tools menu in Quik! when you use Quik! on a PC: 
 

• Map Data Fields… 
• Database Connection… 
• Backup User Files… 
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• Restore User Files… 
• Export All Records 

 
Additionally, you can control the number of forms a user can start at once. This reason to control the 
number of forms is to help PC users manage their PC’s memory and to avoid crashing the computer 
by trying to open too many files at once. By default, a user can only launch 12 Adobe Acrobat files at 
the same time – you can change this by entering a different number. We recommend 12 as a safe 
operating limit and at least 6 to ensure that the Form Group feature allows users to create sufficiently 
large form groups. 
 
 
Installing Forms 
Quik! does not come pre-loaded with any forms. To get forms, you must login to our website, search 
for forms and select the forms you want to add to your personal library (see “Finding Forms” for more 
details). Once you have selected the forms you want, run your Update Service to check for updates 
and to download and install those forms (see the next section “Running The Update Service”). 
 
 
 
Running The Update Service 
To launch the Update Service, open Quik! Forms Library and 
click the “Get Updates” button, located in the upper right 
corner, under the Quik! logo.  
 
The service can be run in Automatic mode (recommended) or 
in Manual mode (you can change your mode by navigating to 
“Settings” and choosing “Update Service Settings…” in the 
menu bar).  
 
 
Modes 
The Update Service can operate in two different modes: Automatic or Manual.  
 
In Automatic mode, the Update Service will check for updates, download any available updates 
(including new forms that you recently found and subscribed to on the website), and then close itself 
after the updates are completed. 
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Manual mode requires that you click the Start button in the Update Service to begin downloading any 
updates. Manual mode allows you to choose which forms you want to download, which is useful if 
you want to force a form to download even if it there are no updates available (for example, perhaps 
you accidentally saved the form with data in it and want a clean copy to use, you may want to force 
the form to download again). 
 
Software Updates 
The Update Service also handles automated software upgrades and updates. Periodically, Quik! 
software will need to be updated to roll out the latest version of the software. While this is handled 
automatically in Automatic Mode, if you wish to update your software manually, check the Show 
Software Updates box.  
 
Install Adobe Acrobat Reader 
For Quik! to display and pre-populate forms, you need to have Adobe Acrobat Reader version 5.0 or 
higher. If you do not have Acrobat, you can download the free Acrobat Reader from 
www.acrobat.com or by visiting our alliances web page and clicking on the link to the Adobe Reader 
there (http://www.etiforms.com/alliances.aspx). Be sure to uninstall any previous versions of Acrobat 
Reader before installing the new one, as previous versions may cause errors when using Quik!. 
 

http://www.etiforms.com/alliances.aspx
http://www.acrobat.com
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Uninstalling Quik! 
To uninstall Quik!, please use your Windows Uninstall program. The uninstall program is found by 
opening the Control Panel, found under the Windows “Start” button and navigating to your “Settings”. 
Open the Control Panel and choose “Add/Remove Programs”. Find the “Quik Forms Library” 
application and choose the “Add/Remove” button. Follow the prompts to uninstall Quik! – this process 
should only take a few moments. 
 
When uninstalling Quik!, not every file will be removed automatically. This is to make sure that you 
don’t lose sensitive data (e.g. the Quik! Database file – quik.eti) or your settings should you decide to 
reinstall Quik! again later. To fully remove the Quik! program after uninstalling, open your Windows 
Explorer (right click on the Start button and choose Explore) and navigate to the Quik! Forms Library 
folder (c:\program files\quik forms library\) and delete the folder and all of it’s contents.  
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Connecting To Your Database 

Supported Databases 
Quik! seamlessly integrates with over 20 databases. This means you do not have to export data 
from your old database or import the data into Quik!. In fact, Quik! does not import your data at all! 
 
To connect Quik! to your database, choose the Tools menu and select Database Connection. The 
database connection screen will appear.  
 

1. Choose a supported database from the drop down list. 
 

2. Browse for your database file located either on your hard-drive or somewhere on your server.  
NOTE: When browsing for your database file, make sure you choose the correct network 
folder or local folder. By default, clicking the Browse button will open a folder where you are 
most likely to find your database, but your database may or may not be in that folder.  
 
Also, when browsing for your database, be sure to check to see if the database file you select 
is the most up-to-date file – if the last modified date of your database is not very recent, then 
you have probably selected the wrong database file. 
 

3. Save your changes. 
 

 
 
OPTIONAL: UserName and Password 
In order for Quik! to access some databases, you may need to enter your database username and 
password. For example, ACT! databases require your exact username and/or password. 
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NEW FEATURE !!! Advisors Assistant – Custom Address Setup 
When connecting to an Advisors Assistant database, sometimes the default settings won’t allow Quik! 
to read your home and business addresses. To fix this situation, you should first look at how you 
categorize your home and business address types within Advisors Assistant. By clicking on an 
address and going to edit mode, you’ll see a drop-down list of address types – click on this drop-down 
to display the address types you have in your database. The default “Home Address” type is HOME 
and the default “Business Address” type is ADDRESS, however, you may have setup a custom type 
like “RESIDENCE” or “H” for Home Address.  
 
If you determine that your database has a custom address type, then next determine if you have 
assigned any client records to that type. The easiest way to find out is to delete the address types you 
don’t plan on using – if any client records have been assigned this address type, a message will 
prompt you with a list of clients who’s records rely on this type, and you won’t be able to delete the 
type. If you have multiple types for home address, then you need to make sure that your client’s 
primary home address (for each database record) is assigned to just one address type.  
 
Next, in the Database Connection window in Quik! (from Tools, choose the Database Connection… 
option), if you are using a custom address type, enter the type name for your home address (e.g. 
HOME for home address) into the Home Address Type and the business address type into the 
Business Address Type box. This will allow Quik! to refer to these type names when searching for 
your client’s home and business address. 
 

 
 
NOTE: If you have multiple address types for home or business, and all are being used, you may be 
able to have Quik! find all of the records by using a “%” in the Home Address Type. For example, if 
you have “H” and “HM” and “HOME” all relating to the primary Home Address type, then if you enter 
“H%” in the Home Address Type box in Quik!, Quik! will find the first occurrence of any address type 
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starting with the letter “H”. Be careful, because if you have any address type that starts with the letter 
“H”, that record may be used instead of the Home Address you intended. 
 
 
Connecting Quik! To Albridge (Formerly StatementOne) 
Quik! has formed a relationship with Albridge to allow Quik! to utilize Albridge data directly. Quik! 
supports Albridge in two ways – Albridge Web Services or Master Client Information export. 
 
Albridge Web Services 
Albridge’s Web Services offers the most dynamic and robust method for an advisor to access clean 
data for use on Quik! Forms. The combination of Albridge Web Services and the Quik! Forms Library 
Database gives you a system that is easy to update and maintain, plus the Web Services offers more 
client data than any other method (e.g. date of birth, social security number, etc.). 
 
NOTE: To use Albridge Web Services, you must first speak with your broker/dealer and/or Albridge to 
be sure that you are setup to use Web Services. If your broker/dealer has not enabled Web Services, 
you will have to use the Master Client Information export. 
 
To setup Quik! with Albridge Web Services, choose Albridge Web Services as your database (see 
image below). You do not need to browse for your database, but be sure to enter your Partner User 
ID (typically your Quik! Username, but it can be anything and is issued by your broker/dealer).   
 

 
 
Click Save when you are done, and you are ready to begin using Quik! with Albridge Web Services. 
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To Import Data From Albridge Web Services 
Once you have set up the Albridge Web Services database connection, the next step is to import your 
data. Start by clicking the Enter Clients button located at the top of Quik! Forms 
Library main screen. The Quik! Forms Database screen will appear. 
 
Next, begin the Albridge import process by clicking the Albridge button located at the bottom of the 
Quik! Forms Database screen. The import process will begin communicating with the Albridge web 
services and automatically import your data – follow the prompts to complete the process. 
 

 
 
Master Client Information Export File 
If you don’t have access to Albridge’s Web Services, you can still use Albridge data with Quik! by 
exporting the Master Client Information report from Albridge.  
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To obtain the Master Client Information report, log into Albridge and go to the Reports section. 
Choose the Master Client Information report and export the data to your hard drive. Be sure to save 
the data file to a location where you can find it easily.  
 
To connect Quik! to your Master Client Information file, choose “Albridge Master Client Export” as 
your database. Then, click the Browse button to find your export file. 
 

 
 
After you click Save, Quik! will modify your export file to make sure it is properly formatted for Quik! to 
use.  

 
 
To refresh the Master Client export file from Albridge, download the new file and replace the existing 
one. Then, from within Quik!, go to the Tools menu and choose Setup Text File to ensure the file is 
properly formatted. NOTE: Only run this process once, otherwise your text file may become corrupted 
and require that you download it again. 
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Use A Text File As Your Database  
Quik! can read a properly formatted text file, enabling you to use data from a non-supported database 
as a data source to pre-populate forms. When setup, Quik! will read the text file as necessary, but 
Quik! will NOT import the text file. This means that if you update your text file, Quik! will be updated 
automatically, allowing you to re-export your data as necessary to the same exact format and file 
name. 
 
Since the connection between Quik! and your text file is dynamic, you can update Quik! by simply 
exporting your text file to the same location (either on your pc or network) and to the same file name 
any time you update your database. The only time you need to change anything in Quik! is when you 
add or remove fields in your export file. 
 
Export Your Data 
Use your database program to export your data into a comma-separated-value text file. The exported 
text file must conform to the following specifications: 
 

1) Include field names as a header. The first record exported should be the field names from 
your database.  
 

2) The first three columns in your export file must be in the following order: 
a. Field 1 = Unique ID – unique record identifier for your database must be in the first field 
b. Field 2 = Last Name – either the client’s last name or full name should be in the second 

field 
c. Field 3 = First Name – either the client’s first name, last name or some other relevant 

field. 
d. The remaining fields can be exported in any order you wish. 

 
3) The data must be exported in comma-separated-value text file (CSV). 

 
4) When exporting your data, if asked for a text delimiter (a character that indicates the beginning 

and ending of a field’s value), use the double quote mark (“) as the text delimiter. 
 

Once you have exported your data, use Quik! to choose the Text Files connector as your database 
(see below). The Database Connection screen is found by choosing Database Connection from the 
Tools menu.  
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Once you have chosen Text File as your database type, then click the Browse button and select your 
text file.  
 
NEW FEATURE !!! OPTIONAL: Ensure Your Text File Setup 
To ensure that your text file is properly formatted for Quik!, you may want to run the Setup Text File 
command from the Tools menu. This function was developed for databases like Maximizer where the 
export file does not contain a truly unique identifier in the first column – running this function will 
correct the problem. 
 
Map Your Data 
Finally, after you have chosen your text file, you will need to map to the data from your text file to the 
fields available on forms. The process of mapping data will only have to be done the first time you 
define your export file or if you change your export file. Please see the Advanced section titled 
Manage Data Fields for instructions on mapping your data to Quik!. 
 
 
Non-Supported Databases 
If your database is not listed in the drop-down list, please let us know which database you use by 
sending an email to: support@etiforms.com.  
 

mailto:support@etiforms.com
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Rep Information 

Update Rep Information 
To update Rep Information, select “Settings” from the menu and then select “Rep Info”. Or click the 
Rep Info button on the Quik! Forms Library screen. When the Registration screen appears, type in 
any of the data you wish to update. The only field you cannot change from this screen is the Rep 
Name that appears on your forms. To update your Rep Name, click on the Rep Name field, which will 
log you into the website and allow you to update your rep name. 
 
There are four major pieces of rep information that may appear on forms: 
 

- Personal Office Information – enter the rep’s phone number, address, personal info etc. 
 

- Rep Numbers – enter as many rep numbers or variations of rep numbers as you’d like. 
 

- Branch Office Information – This information relates to the registered branch office that you 
work through. If your personal and branch addresses are the same, click the Use Personal 
Address button to save time. 
 

- Broker/Dealer Headquarters Information – Broker / Dealer information is mostly used on 
forms for other companies (e.g. mutual funds) where your firm has a selling agreement. If your 
branch and broker/dealer addresses are the same, click the Use Branch Address button to 
save time. 
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Managing Forms 

Adding Forms (Subscribing To Forms) 
Adding forms is done online at our website. The easiest way 
to login to the website to add forms is from within the Quik! 
Forms Library. Simply choose “Online” on the menu bar and 
then choose “Find More Forms…”. Your web browser will be 
launched and you will be automatically logged into our 
website and taken to the Find Forms page.  
 
From within the Find Forms web page, search for forms by 
dealer or keyword. Once you find the forms you want, checkmark the form in the ADD column, and 
click Save Changes at the bottom of the page. 
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Removing Forms (Unsubscribing To Forms) 
Removing forms is done online at our website. The easiest 
way to remove forms is login to the website from within the 
Quik! Forms Library. Simply choose “Online” on the menu 
bar and then choose “Remove Forms…”. Your web browser 
will be launched and you will be automatically logged into our 
website and taken to the My Forms page.  
 
From within the My Forms web page, find the form you wish 
to remove and place a checkmark in the REM column, and 
click Save Changes at the bottom of the page. 
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Create A Group of Forms 
One of the more powerful features of Quik! is the ability to define groups of forms. For example, you 
might create a group of the forms required to open a new account. Then, 
whenever you need to open a new account, choose the New Account 
group and all of the required forms will be pre-selected. Plus, you can 
always add or remove forms from the pre-selected group before clicking 
the START button. 
 
To create a group, click the “New Group” button on the main Quik! 
screen.  
 
In the Form 
Groups 
window, start 
by typing the 
name of the 
group you wish 
to create. 
 
Next, 
checkmark the 
forms you wish 
to add to the 
group. 
 
Finally, click 
the Save 
button to save 
your group.  
 
You can also 
delete a group 
by choosing 
the group 
name and 
clicking the 
Delete button. 
 
NEW FEATURE!!! Search For Forms: Use the Keyword Search at the top of the Form Groups screen to find 
the forms you need. Enter one or more words and click the Search button or <ENTER> key on your keyboard. 
The search will only display the forms that match your search word(s). After you check the forms you want, you 
can search again and the forms you selected will remain at the top of the list. If you want to clear your search 
but keep your selected forms, click the Clear button. To reset your search and selected forms, click the Reset 
button.  
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Request A Form 
If you need a form built that we don’t currently have in our system, please send the form to us. In 
most cases, we will build the form for free within 10 business days, if not much sooner.  
 
To request a form, first download the form from your dealer’s website and save it on your hard-drive.  
 
Second, click on “Request A Form” from the Online menu within Quik! Forms Library. Then, your web 
browser should be launched and the Submit Form Or Dealer Request screen should appear (see 
below). Click on the Send Form link below. 
 

 
 
Next, the Send Us Your Form page will appear, enabling you to upload your file directly to our server. 
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To upload your file, click the Browse button and select the file you wish to upload. Second, type in a 
dealer name (the company whose form you are sending), the form name (the name that describes 
the form, not the file name per se), a description of how the form should be used (e.g. “use this form 
to open a new account”) and any instructions you wish us to have about this form. To complete the 
upload process, click the Upload File button.  
 
Please repeat this process for each form you wish to send to us – that way each request is logged 
into our system and we know exactly who sent the form to us. 
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Using Quik! 

How Quik! Forms Library Works 
Creating forms with Quik! is a three-step process: choose a client, choose a set of forms and start 
forms.  
 
Step 1 - Choose a Client 
Start by choosing a client, or leave the client drop-down blank to create a blank form. You also have 
the option to choose a spouse or joint relationship to the client.  

 
Client vs. Spouse vs. Joint: The Client, Spouse and Joint radio buttons under the Client 
drop-down box are intended for use with databases where client and spouse, and other 
relationships, are stored. Such databases include dbCAMS and some versions of ACT! and 
Goldmine. By choosing spouse, the form will be created for the spouse record. If you choose 
Joint, the form will be created for the client and spouse information will be entered for any joint 
information on forms. 

 
 
Choose a Contact: If you are using dbCAMS+ or another database that supports additional 
levels of detail, you can also choose a related client name. For example, choosing a Contact 
allows you to choose anyone in the client family that you have entered into your database. 

 
 



Quik! Help   

  39  

 39  

Choose a Client Account: If you are using dbCAMS+ or another database that supports 
additional levels of detail, you can also choose a related account for the owner you chose. For 
example, choosing an account will populate the form with the account registration and account 
number if applicable. 

 
 

Step 2 – Select Forms 
Forms can be selected one by one or as a group.  

Individual Forms: Each form can be selected individually by scrolling down to the correct form name 
and placing a checkmark for each form. Be careful not to select more than 12 forms at a time. 

 
 

Form Groups: One of the best ways to use Quik! is to setup groups of forms to make selecting forms 
easier. Choose from a list of groups that you established to automatically choose all of the forms 
required by that group. For example, you might have a group called New Account Forms that includes a 
new account form, an order ticket, a signature guarantee and prospectus receipt. Instead of selecting 
each form individually, setup a group so you only have to select the group name. You can also add or 
remove any forms to the group at any time. 
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NEW FEATURE!!! Search For Forms: Use the Keyword Search at the bottom of Quik! to find the 
forms you need. Enter one or more words and click the Search button or <ENTER> key on your 
keyboard. The search will only display the forms that match your search word(s). After you check the 
forms you want, you can search again and the forms you selected will remain at the top of the list. If 
you want to clear your search but keep your selected forms, click the Clear button. To reset your search 
and selected forms, click the Reset button.  

 

Step 3 – Start Forms 
When you press the Start button, Adobe® Acrobat® will start and display up to 12 forms at a time. 
You can now edit the forms and complete them before printing.  
 
 
Adding Additional Names  
Quik! now supports additional names on forms including: 

• Joint / Spouse 
• Contract Owner 
• Annuitant (up to 4) 
• Beneficiary (up to 4) 

 
When starting forms, if you check the “Add Annuitant/Beneficiary” check box, an Additional Names 
screen will appear allowing you to choose a joint, owner, annuitants and beneficiaries using client 
data stored in your database. In other words, anyone in your database can be used as an additional 
name on your forms. 
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After selecting your additional names, click the Continue button to start your forms. 
 
NEW FEATURE !!! Combine Forms Together 
If you check the “Combine Forms” checkbox located to the right of the START button, all the forms 
you selected will be combined together into a single Quik! Form. This allows you to put all the 
required forms together into a single document and only have to print one document. Also, when you 
change the data in a field that appears in multiple places on a form (like the client first name), the 
changes you make will flow through the entire document! 
 
NOTE: The Combine Forms feature requires an active internet connection and will make a request of 
the Quik! server to combine the forms together and then download them to your browser. Then, once 
the forms are downloaded, your client data is populated onto the resulting form. Please be assured 
that NO client data is ever being sent to the Quik! server. 
 

 
 
NEW FEATURE !!! Launch Forms From Web 
If you check the “Launch Forms From Web” checkbox located to the right of the START button, each 
form you select will be launched directly from the Quik! web server. This ensures that the forms you 
start are always the most up-to-date versions available from Quik!.  
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This feature was designed to assist users who want to install Quik! Forms Library in more than one 
location (e.g. on the network at the office and on a remote office or home office computer). Quik! is 
designed to be used on one PC or network at a time due to how the Quik! Forms are downloaded. If 
you were to install Quik! on a remote computer, then the second installation would not be able to 
download the forms reliably and it will become difficult to know which computer has the latest 
versions of the forms. By checking the “Launch Forms From Web” checkbox on the second 
installation of Quik!, your forms will always be launched directly from the web and your first install can 
continue to run the Update Service to download the latest forms.   
 
NOTE: The Launch Forms feature requires an active internet connection and will make a request of 
the Quik! server to combine the forms together and then download them to your browser. Then, once 
the forms are downloaded, your client data is populated onto the resulting form. Please be assured 
that NO client data is ever being sent to the Quik! server. 
 
 
Completing and Printing Forms 
With the forms showing on the screen you will see that some data has already been pre-populated. 
From within Acrobat, you can now edit all of the fields, including the fields already filled from the 
database.  
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If you launched multiple forms, they should also be open, but you may not immediately see them. To 
find your other forms, choose Window from the Acrobat menu bar and look at the bottom for 
additional open files.  
 

 
 
Once you have filled out all necessary fields, the form is ready to print.  Some forms have pages you 
may not want to print.  In those cases, by selecting File, Print from the menu, you can select which 
pages to print from in the print dialog box. 
 
Saving Forms 
In some cases, you may wish to save forms that you completed. For example, some users prefer to 
email the completed forms to clients for the client to print, sign and return. To do this, you must save 
the form as a new file in a new location. 
 
NOTE: Saving forms is a feature only available in the full version of Adobe Acrobat or the 
Adobe Acrobat Approval product. Both products are available for purchase at Adobe’s 
website (www.acrobat.com) and are not products provided by Efficient Technology Inc or 
bundled with Quik!. 
 
From within Adobe Acrobat, choose File > Save As. Navigate to a new folder and rename the file. 
CAUTION: If you keep the file name and folder location the same, you may overwrite the actual 
form template, causing the same data to appear every time you try to create this form.  
 

http://www.acrobat.com
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A saved form can be reopened later, but cannot be re-populated from Quik!. Saving a form is mostly 
useful for documentation purposes – it is recommended that a new form be generated from Quik! 
each time you need one to ensure the most up-to-date data and version of the form is used. 
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Online Menu Features 

Quik!’s Integrated Online Menus 
Quik! comes with an online menu that integrates the use of the Quik! Forms Library software with our 
website. 
 
The Online menu gives you immediate and easy-to-use access to our site without requiring you to 
know your username, password or even the page you have to find. Simply choose an item from the 
menu and Quik! will automatically launch your web browser, log into www.quikforms.com and take 
you to the exact page you need to be on. See the graphic below for a list of menu items. 
 

 
 

http://www.etiforms.com
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Update Forms Now 
One of several ways to update your forms, clicking Update Forms Now will launch the Quik! Update 
Service which will check the quikforms.com website to determine if any of your forms need to be 
updated. 
Find More Forms 
If you need to add more forms to your library, click Find More Forms to be transported to the Find 
Forms page on our website. From the Find Forms page you can quickly find and add more forms to 
your library. When you’re done adding forms, don’t forget to click on Save Changes and then to run 
your Update Service to download and install the new forms. (See “Managing Forms” section for more 
detailed instructions on adding forms.) 
 
Remove Forms 
To remove a form from your library, click on Remove Forms. This item will take you to the My Forms 
screen where you can review and remove forms you no longer wish to use. (See “Managing Forms” 
section for more detailed instructions on adding forms.) 
 
Request A Form 
If you need a form built that we don’t currently have in our system, please send the form to us. In 
most cases, we will build the form for free within 10 business days, if not much sooner. To request a 
form, first download the form from your dealer’s website and save it on your hard-drive. Second, click 
on Request A Form from the Online menu. (See the “Managing Forms” section for more detailed 
instructions on sending a form to us). 
 
Unlock Private Forms 
Quik! provides forms that are both public and private. Private forms are for dealers who do not want 
every advisor to access without some form of authentication. Quik! works with several companies 
whose forms are private. Click Unlock Private Forms to login to our website and enter a code that will 
give you access to the forms you want. You may need to request the code from your dealer first. 
 
Change Rep Name 
If you need to change the rep name for your copy of Quik!, simply choose the Change Rep Name 
item and you will be prompted to enter the new rep name on www.quikforms.com.   
 
Login To QuikForms.com 
If you would simply like to login to our website and do your own navigating/exploring, choose the 
Login option from the Online menu.  
 
My Account 
Use the My Account item to login and manage your account. The My Account section of our website 
allows you to manage your billing and customer information, renew your subscription, download 

http://www.etiforms.com
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software, change your website password and rep name, and subscribe to private forms. Simply click 
the link you wish to view. 
 

 
 
Renew Account 
When it becomes time to renew your Quik! subscription, click the Renew Account feature to 
automatically log into our website and renew.  
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Advanced Features 

NEW FEATURE !!! Connect Quik! To Multiple Databases 
If your office supports multiple advisors who use different databases, Quik! can be setup to support 
each rep and their own database program.  
 
Quik! supports multiple advisors on a single installation of Quik! by purchasing a Multi-Rep license 
(contact us for more details). Multi-Rep licenses support up to one unique database connection per 
license or rep. So, if one Advisor is using ACT! and another is using dbCAMS+, both advisors can 
use the same copy of Quik! when installed on a network and use their own database to pre-populate 
forms. 
 
Setting up Multiple Database support is similar to setting up the first database. By default the primary 
database connection (the database you chose when you initially configured Quik!), belongs to the first 
advisor and any other advisors who have not connected Quik! to another database.  
 
REQUIREMENTS 

• Quik! must be installed on a network 
• You must have a Multi-Rep license for at least 2 reps 
• You can only have one rep using the Quik! Database or Albridge Web Services (which uses 

the Quik! Database) 
 
 
To setup an additional database connection for an advisor, do the following: 
 

1. Click the Rep Info button in Quik! Forms Library. 
2. Navigate to the rep that you want to setup the database for by clicking the Next button. 
3. Click the Assign Database button. 
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4. In the Database Connection screen, choose the rep’s database and browse for the database 
file, and click Save. 

 
Populating Forms Using Multiple Databases 
Choosing which database to use to pre-populate forms is as simple as choosing a rep name. When 
you are ready to start creating forms for an advisor, start by selecting the advisor from the Rep Name 
drop-down list located under the Quik! logo (see image below). Each time you select a rep, the 
database for that rep will be selected as well – the screen may take a moment to refresh.  
 



Quik! Help   

  51  

 51  

 
 

By selecting a rep, which then switches databases, you can easily control which client data you are 
using on forms for a rep. For those reps who have not been assigned a database, the primary 
database will be used. For example, if rep 1 and 2 are sharing an ACT! database and rep 3 has a 
dbCAMS+ database, the choosing rep 1 or 2 will connect Quik! to the ACT! database, while choosing 
rep 3 will select the dbCAMS+ database automatically.  
 
To Unassign A Rep Database 
To remove a rep database assignment, open the Rep Info screen and click the Unassign Database 
button and the rep will revert back to using the primary database again. 
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Manage Data Fields 
The “magic” of Quik! is the ability to seamlessly connect directly to your contact management 
database without you having to work through a tricky configuration. We accomplish this “magic” by 
mapping the data fields between your database and Quik! for you. However, in some cases, you may 
be using your database differently than the average user does or you may have defined custom fields 
that you would like Quik! to use. For example, not all databases have a field for social security 
numbers and you may have defined a custom field to capture that data. Since Quik! is not pre-
configured to match your custom database configuration, you may want to modify the data map. 
 
Quik! allows you to map the data fields to custom fields in your database. While this sounds 
complicated, it is actually a lot easier than you may anticipate. Simply follow these instructions to map 
your fields more precisely. 
 
To Modify Your Data Map 

1. Select “Tools” from the menu bar and then click “Map Data Fields”.  
 

2. The Map Data Fields window will appear with two sets of data. In the box on the left is a list of 
fields available in Quik! (heading says “Field Description”) with an associated database field 
assigned to it (heading says “DB Fields”). In the right list box is a list of database fields from 
your database 
with sample 
data listed 
next to each 
field (if 
available).  
 

3. To change a 
field mapping, 
click once on 
the field name 
you wish to 
modify in the 
left box. Notice 
that the name 
of the field on 
the left now 
shows up in 
blue ink on the 
right side 
under Field 
Description. 
 

4. Next, select the field in the right list box that you want to map to the field from the left list box. 
 

5. After selecting the field on the right, notice that the field on the left now has the name of the 
field on the right next to it. 
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To clear a data mapping, double-click the field you wish to clear in the left-hand box. 
 
After mapping all of your fields, be sure to click the Save button. You can also reset your data map at 
any time by choosing the RESET button. Or, if you want to restore the originally installed map, 
choose the Restore Defaults button. 
 
 
Backup / Restore User Files 
Quik! has made it easy for you to backup and restore your user files, especially when you are 
reinstalling Quik! or moving Quik! to your network. Quik! relies on several files to contain information 
about your Quik! configuration, including: 
 

• Rep Information and Rep Numbers 
• Form Groups and Forms 
• Quik! Database Mapping File 
• Quik! Forms Library Database 
• Quik! User Settings 

 
If you wish to backup and/or restore these files, choose either Backup User Files or Restore User 
Files from the Tools menu and Quik! will automatically backup your files. Quik! saves up to three 
backup copies to ensure you don’t lose valuable information.  
 

 
 
View Client Form Log 
To better assist you in tracking which forms you started for which clients, Quik! now tracks which 
client(s) and form(s) you chose and the date in which you started the form. Each time you start a 
form, a record is added to the Client Form Log. The log file is automatically saved as 
“QuikFormsGeneratedLog.csv” in the folder where you installed Quik!.  
 
To view this file, click View Client Form Log in the Tools menu. The file is a comma-separated file that 
is ideal to display in Microsoft Excel, but can also be shown in any text editor such as Notepad.  
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If you wish to clean out the Client Form Log, you can either delete the file from your hard-drive and a 
new one will be created by Quik!, or you can open the file, delete the data and save the file.  
 

 
Scheduling The Update Service 
If you would like to have the Update Service run on a schedule (which is ideal for those installing 
Quik! on a network server) then schedule the Update Service in the Windows Scheduled Tasks on 
the PC or server where Quik! is installed. 
 
To schedule the Update Service, use the Microsoft Windows Scheduled Task Wizard, as described 
below. 
 

1. On the Windows Start menu, click Programs > Accessories > System Tools > Scheduled 
Tasks. 
 
For Windows NT 4.0, you can access the Task Scheduler in My Computer; or on the Windows Start menu, click 
Programs>Administrative Tools>Scheduled Tasks). The Scheduler tasks are located in C:\WINNT\TASKS. 
 

2. In the Scheduled Tasks folder, double-click the Add Scheduled Tasks icon. 
 

3. Follow the instructions in the Scheduled Task Wizard. 
 

4. When you are asked to click the program you want Windows to run, select "Quik! Update 
Service" from the Application list. 
 

5. Continue following the instructions in the Scheduled Task Wizard to set the frequency and time 
at which you want the Update Service to start. 

 
When you have successfully scheduled the Update Service, the Update Service icon and its schedule 
information are listed in the Scheduled Tasks folder.  
 
Note: Your normal Internet access fees apply when you use Update Service. Automatic Update 
Service requires both Microsoft Internet Explorer 5.0 or later and Microsoft Task Scheduler installed 
on your computer. The Microsoft Task Scheduler requires the full (not minimum or custom) 
installation of Internet Explorer 5.0, including the Offline Browser Pack. 
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Support Resources 

Quik! Help 
Quik! has made it easy for you to contact customer service. From within the Quik! Forms Library, you 
can contact us immediately by either sending us an email and/or sending us your error log.  
 
We recommend that you send us your error log anytime you have an error, that way we will be better 
able to understand the problem you are having. Plus, we’ll get your message right away and respond 
to you immediately. 
 
Send Errors To Support 
From the Help menu, choose Send Errors To Support. Quik! will then submit your error report to our 
support team without you doing anything else. You’ll receive a confirmation email and a response 
from us as soon as possible. 

 
 
Send Us An Email 
Quik! also offers you the ability to send us an email from our website. From the Help menu, choose 
Send Email To Support. Your browser will be launched and you will be logged in to our send email 
page. Type in a message, attach (upload) a file if you’d like and send your email to us. 
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NEW FEATURE !!! Search Knowledge Base 
We offer an extensive Knowledge Base on our website. You can search our knowledge base for 
frequently asked questions, product support, installation issues, etc. Every time we learn something 
new based on a question from a customer, we enter it in our knowledge base so you can have 
immediate access to it. If you have a question, try our searching our knowledge base. 
 

 
 
 
Other Help Features 
We also offer an extensive online support section. Visit our online support by clicking Get Help Online 
from our Help menu. Or, you can email your questions to help@etiforms.com. 
 
 
Live Help 
We pride ourselves on our ability to service our customer’s needs. If you need help and can’t figure 
out the solution on your own, don’t wait another second – give us a call.  
 
We understand that your first job is to service your customers, not technology, so rely on us to be 
your technology expert when it comes to setting up and using Quik!. Feel free to contact us via email 
or phone, and we will do everything we can to solve your problem within 24 hours, if not within the 
same hour.  
 
 
Contact Information 
 
Phone: (909) 624-7988 
Email:  support@etiforms.com 
 
Web: www.etiforms.com/support.aspx  

mailto:help@etiforms.com
mailto:help@etiforms.com
http://www.etiforms.com/support.aspx
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